
July 2014 Master Load and Update 
 
 
 

The July 2014 Master Load is the newest master load for the AristoCAT 
software.  It works with the Windows XP, Vista, Windows 7, Windows 8 & 8.1 and 
Windows 10 operating systems (both 32 and 64-bit).   
 
The following is a list of changes incorporated in this update.  The changes are 
listed in reverse chronological order, so that the most recent changes are listed 
first. 
 
 
August 14, 2016 
A change was made to Edit so that it is not affected by the Windows 10 Print 
Spooler.  Sometimes Edit would not start because of the Windows 10 Print 
Spooler and this has been fixed. 
 
 
June 27, 2016 

 Edit – two changes have been made to Edit: 
1. Under Edit preferences a new option has been added, ‘Beep when Caps 

Lock Pressed”. If you check this box then each time you press the Caps 
Lock key, your computer will beep.  It will beep when you press it to turn 
on Cap Locks and beep when you press it to turn it off.  The sound will be 
different when pressing it on than when pressing it off.  Remember that 
the word ‘Caps’ will appear in red in the bottom left corner of the grey 
status line when the Caps Lock is on. 

2. When you have a file open in Edit, you can click on the ‘Format’ menu and 
then click on the ‘Change to All Uppercase’ menu item and the entire 
transcript will be converted to all upper case.  Note:  If you make a 
mistake and convert it to all upper case or you need to convert it to upper 
case for a certification test, you can click on the ‘File’ menu and then 
‘Abandon’ to get out of Edit without saving the text in uppercase. 

 Real-time and Translation – An option has been added to both programs 
‘Save UpperCase’ that allow you to save the text in all upper case.  Note:  
Neither program will remember if you checked this box the last time you did 
real-time or translated.  If you want the text saved in uppercase you will have 
to check it every time.  If you forget to check this box and you need the text in 
all upper case, you can open it in Edit and convert it that way.  See item #2 in 
Edit above. 

 Print – a check box has been added to the ‘Print Options’ dialog box to print 
in uppercase. 

 
 
June 15, 2016 



 AristoCAT Main Menu – a new menu has been added named ‘Updates’.  
Under this menu is ‘Last Update’ which tells you the last time you did an 
update, ‘Install Update’ which will install the latest update and ‘Update 
Details’ which lists a description of the updates. 

 Reorganize Global File – this option will remove globals from a global file 
that have also been added to your personal and/or job dictionary.  If you 
have a really large global file, this option will reduce its size.  Before using 
this option, you will want to make sure that the global entries to be 
removed have been updated to your personal and/or job dictionary.  To 
find this option, start the Edit program and when asked for the name of the 
file to edit, click the Cancel button.  Now click on the Globals menu and 
then click ‘Reorganize Global File’. 

 Real-time and Translation – you now can have the real-time and 
translation programs ignore the number bar.  If you don’t use the number 
bar but you find that you are accidently hitting the number bar causing 
untranslates or extra work adding entries to your personal dictionary you 
can now tell these programs to ignore when you press the number bar.  
To set this option, open your information file, click the ‘Tran Options’ tab 
and in the bottom left corner check the box ‘Ignore Number Bar’.  Notes:  
If you check this box, when you view the steno along with the translation 
as in the View Notes program or recalling steno twice in Edit you will still 
see the # sign (number bar) in the steno but the translation will be what it 
in your dictionary without the number bar.  For example the steno may 
appear as ‘#1’ but the translation might appear as ‘is’ (assuming your first 
‘S’ in steno is defined as ‘is’.  This may appear confusing at first, but we 
feel it is important to maintain the note file as it was written.  This gives 
you the ability to uncheck this box and retranslating the note file if you find 
you don’t like this option.  Checking this option will not affect entries in 
your personal dictionary you have previously defined with the number bar.   

 Edit – two options have been added to Edit Preferences. 
1. Disable Insert Key – are you reaching to press the Home key and 

accidently pressing the Insert key instead, going into overwrite 
mode?  If you check this box, then pressing the Insert key will be 
ignored.  You still have the option to use the control command to 
toggle the Insert key regardless of whether this box is checked or 
not.  This control command is Ctrl+V. 

2. Enable Drag&Drop – If this box is checked, you can drag 
highlighted text to a different point in the transcript.  To drag and 
drop text, highlight the text, place the mouse cursor anywhere in 
the highlighted text, hold down the left mouse button, move the 
cursor to where you want to place the text and then release the left 
mouse button.  If you want to use this option, you may want to 
practice first and if you make a mistake you can always abandon 
Edit and the changes won’t be saved (you don’t want to do this if 
you have done a lot of editing first).  Important Note:  You will not 
be able to recall steno or play sound for the text you moved, so you 



will want to edit that section first, listening to the sound if desired 
and then drag and drop it. 

 Several Help buttons have been updated. 

 Minor glitches have been fixed. 
 

 
April 13, 2016 

 Print and MultiPag – a change was made to the ‘.im’, ‘.lf’, and ‘.lh’ dot 
commands that allow you to move ‘.bmp’ files up or down on the page. 
The ‘.im’ dot command is commonly used to print your signature and now 
you can move the signature down on the page closer to the signature line.  
The ‘.lf’ is the dot command to print a logo on the footer.  Now you have 
the option to move the logo up or down on the page.  The ‘.lh’ dot 
command is used to print the logo on the header.   It also can be moved 
up or down.  To see how to move a logo see Appendix C in the User’s 
Manual on the bottom toolbar on the AristoCAT Main Menu.  Note that 
these changes work with both the printed transcript and the PDF file. 

 Edit -- A change has been made that allows you to resolve a conflict 
without having to highlight it with the Home key.  To resolve the conflict 
place your cursor on the open curly bracket (‘{‘) of the conflict and press 
the desired number of the conflict.  Important Note:  If you highlight a 
conflict using the Home key, you can resolve to the first conflict by 
pressing either ‘1’ or the Enter key.  If you want to resolve a conflict with 
the cursor on the ‘{‘ without the conflict being highlighted you must press 
the ‘1’ key. The Enter key will not resolve to the first conflict in this case. 
 

 
January 19, 2016 

 Real-time – a new RT command has been added, ‘RT-UNTRAN*’.  If you 
use ‘RT-UNTRAN’ to ‘fix’ an untranslated, you can use ‘RT-UNTRAN*’ to 
delete an untranslate.  See the User’s Manual for detailed information.  
The corrected text is refreshed to Bridge. 

 File Management – a new menu item has been added, ‘Search’.  You can 
search on the hard drive or the removable media for a file name.  You type 
in all or part of the file name and the File management program will scroll 
into view the closest match to the file name you typed in.  Click the Help 
button for detailed instructions. 

 A new menu item has been added to the AristoCAT Main Menu, 
‘Updates’.  Clicking on this menu gives you the option to see what update 
is installed and when it was installed.  You can also install an update from 
this menu.  In addition, a ‘Scopist Page’ menu item has been added to the 
‘Web Site’ menu. 

 Updated documentation for include files. 
 

 
December 23, 2015 



 Real-time  – We added more editing functions which refresh to the Bridge 
litigation software.  To enable Bridge refresh, click on the Real-time Output 
button on the Real-time Options screen and then check the box ‘Bridge 
Refresh’.  A detailed description of what real-time editing functions get 
refreshed to Bridge can be found at the end of the Real-Time chapter in 
the User’s Manual.  Note:  This only works when you are connecting to 
viewers using the Bridge software. 

 Real-time – A change was made, along with a change from Stenograph, 
to allow the Luminex to work with the USB real-time cable. 

 Edit – More Windows Control commands have been added.  To see what 
Windows Control Commands are available, open any file in Edit, click on 
the Preferences icon on the tool bar, then click the ‘Windows Ctrl Cmds’ 
button.  The Help button will describe what each command does.  If you 
are not familiar with how this works, by checking one or more of the 
commands, when you do a Ctrl+letter (such as Ctrl+C for copy) then Edit 
will emulate the way Windows works rather than the way Edit works in its 
native mode (Ctrl+C is page down). 

 File Management – do you have a lot of files and you want to find a file 
without having to scroll through a lot of files?  If you press the first letter of 
the file name, the File Management program will scroll to the beginning of 
files that start with that letter.  Note:  If you type a second letter, the File 
Management program will scroll to the files what begin with that letter and 
not to the files that start with the first and second letter. 

 Print and Multipag programs – we have enhanced the ‘.vl #’ dot command.  
You can now add a description after the volume number.  This description 
will appear in the bookmark section of a PDF file and gives the recipient of 
the PDF file more information about the volume number.  More information 
about this dot command can be found in Appendix C of the User’s Manual.  
Example: 
 

.vl 2,Smith vs Jones – Day Two 
 

 More newsletters have been added and the newsletter index has been 
updated in Newsletters on the Resources icon. 

 Some tutorials have been updated in Tutorials on the Resources icon. 

 Other minor enhancements and glitch fixes have been made.  
 

 
October 12, 2015 

 Real-time Program – Briefs found during real-time are now added to a job 
dictionary named ‘adcBriefs.job’.  By adding briefs to a job dictionary it is easy 
to move entries from the job dictionary to the personal dictionary batch file, 
search the job dictionary by steno or English, etc.  Also, to maintain 
consistency, the name of the ‘brief.txt’ file is now named ‘adcBriefs.txt’.  The 
real-time program will automatically rename ‘briefs.txt’ to adcBriefs.txt’. 



 Translation Program - To maintain consistency with other briefs file names, 
the name of the ‘brief.txt’ file is now named ‘adcBriefs.txt’.  The translation 
program will automatically rename ‘briefs.txt’ to adcBriefs.txt’.  Currently the 
translation program does not add found briefs to the ‘adcBriefs.job’ job 
dictionary, but will do so in a future update. 

 File Management Program – a new menu item has been added.  The new 
menu item is named ‘Duplicate’ and gives you the option to make a duplicate 
copy of a file or a job.   

 Both the Print and Multipag Programs now recognize the ‘.VL’ (volume) dot 
command (dot commands are case insensitive).  The format of the volume 
dot command is ‘.vl x’ where x is an Arabic number indicating a volume 
number.  You might find this dot command useful by merging several jobs 
(volumes) into one .wrk file and then inserting ‘.vl 1’ at the beginning of the 
first volume, ‘.vl 2’ at the beginning of the second volume, etc.  Now when you 
make a word index, it will indicate in which volume the words appear.  If you 
start each new volume with page 1, then you will also have to add the dot 
command ‘.pn 1’ at the beginning of each volume.  Hint:  In the Multipag 
program you can make a word index only (either printed or as a PDF file) 
which you can give to your clients. 

 Other minor enhancements and glitch fixes have been made.  
 
Note:  File and folder names in Windows are case insensitive.  For example 
‘adcBriefs.txt’, ‘adcbriefs.txt’ and ‘ADCBRIEFS.TXT’ are all the same file. 
 
 
May 21, 2015 

 Translation Program – you can now have the translation keep track of briefs 
that could have been used.  If briefs are found during the translation, you will 
get a message at the end of translation that briefs were found.  The list of 
briefs found is stored in a file named ‘brief.txt’.  You can view this list using 
Notepad or other programs.  You can even make a new, empty .wrk or.inc file 
and insert the ‘briefs.txt’ file into it.  To set up the briefs option: 
1. Start the Translation program and when asked for the name of the file to 

translate, click the Cancel button. 
2. Now click on the Edit menu in the upper left and then click on the 

Preferences menu. 
3. Now click the Briefs Options button and fill out the desired fields.  Click the 

Help button for a description of the fields. 

 Real-time Program – The following enhancements have been made to the 
real-time briefs. 
1. When a found brief is displayed in the briefs window during real-time, it will 

indicate where the brief came from (ie: personal dictionary, a brief 
dictionary or a job dictionary). 

2. Like the translation program, the real-time program also creates a file 
named ‘brief.txt’.  See the description above for information on viewing this 
file. 



3. There are two brief job dictionaries that are included with the software.  
One is named Common Briefs and the other is named Mark Kislingbury.  
There are now check boxes to make it easy to add these dictionaries to be 
searched for briefs. 

Important Notes: 
1. The briefs.txt file generated by the translation and real-time programs is 

cumulative.  That is, the translation and real-time programs will keep 
adding to the list of briefs found and this will cause the briefs.txt file to 
keep getting bigger and bigger.  Every once in a while, after viewing it, you 
may want to erase it.  If you erase it, a new one will be created the next 
time you translate or do real-time.  Note:  As indicated above in the 
October 12, 2015 update, the ‘briefs.txt’ file is now called ‘adcBriefs.txt’. 

2. Mark Kislingbury has graciously offered the free use of his dictionary.  Be 
sure to visit his web site, www.magnumsteno.com, for other products that 
will be of help in making your life easier. 

 Other minor enhancements and glitch fixes have been made.  
 
 
March 16, 2015 

 Automatic Indexing in Edit 
1. If you separate your witnesses and exhibits by Plaintiff’s/Defendant’s (or 

Petitioner’s/Respondent’s, etc.) you probably know that there is a drop 
down list to give you other descriptions.  Did you know that you can click 
in this field and type your own description?  For example, you may want 
the description to be in all upper case (ie: PLAINTIFF’S\DEFENDANT’S).  
If the description is in all upper case then the words ‘Witnesses’ and 
‘Exhibits’ will also be in all upper case.  This is consistent behavior with 
autofill. 

2. A file will now be generated (the name of the job with an ‘.ait’ extension).  
This file is used by the Print and Multipag programs to generate links to 
witnesses, examinations and exhibits in the Bookmarks tab when you 
make a PDF file.  The recipient of the PDF file can click on these links to 
go directly to the witnesses, examinations and exhibits in the transcript.  
When you get to the Automatic Indexing Options dialog box, there is a box 
you have to check to produce this file. 

 Print and Multipag – the Print and Multipag programs have two 
enhancements: 

1. As described above, under automatic indexing, you have the option of 
having witness names, examinations and exhibits appear in the 
Bookmark tab of a PDF file.  Note that in order for this to work, you 
must use the automatic indexing feature in the Edit program.  The 
automatic indexing from the AristoCAT Main Menu does not generate 
the file needed. 

2. An additional option has been added to the ‘.im’ dot command.  This 
option allows you to have an image appear in a PDF file, but not when 
you print the transcript to a printer.  You may find this option most 

http://www.magnumsteno.com/


useful when printing an image of your signature.  You may want your 
signature to appear in a PDF file, but you may want to hand sign a 
printed copy.  The new format of the ‘.im’ dot command is: 
.im bmpfile, offset, [width], [height], [no advance], [description], [PDF 
Only] 
 
See Appendix C (Dot Commands) of the User’s Manual for more 
detailed information. 
 

 
February 5, 2015 

 Read Notes program 
1. If you have a writer such as the Diamante, Stylus, etc. that stores the 

note files in separate folders you can now change from folder to folder 
without having to exit and then restarting the Read program.  A 
‘Browse …’ and a ‘Chg Month’ buttons have been added to the dialog 
box which shows the note files. 

2. In the past, if you view a note file, you would have to close out the 
View window before you could read the note file.  You no longer have 
to close out the View window before reading a note file. 

 File Management program – an option to print all or some of your include files 
has been added.  When the File Management program is open, click on the 
‘Include Files’ menu then click on ‘Print Include Files’.  You have the option to 
print to a printer or to a PDF file. 

 Several glitches have been fixed including real-time defines in the Real-time 
program, several minor problems in the Edit program, etc. 

 
 
December 12, 2014 

 Dictionary Management – when reviewing your batch file or editing your 
personal or job dictionary the “Find Steno” search has been enhanced.  You 
now have the option to search for entries that starts with or ends with a 
certain stroke or a certain letter contained in a stroke.  In addition there is the 
option to show all occurrences of dictionary entries that meet the search 
criteria.   

 
November 23, 2014 

 Edit Program – When you make a definition there is a new addition 
labeled ‘Globals:’.  This is a dropdown list of all of the English spellings of 
the globals you have made for this job.  This list is handy for checking the 
spelling of a global that you may have written differently throughout the job 
and not remember the correct spelling. 

 Dictionary Management Program – the ‘Merge Job Dictionaries’ has been 
enhanced.  You now have the option to have the ‘Merge Job Dictionaries’ 
show you duplicate job dictionary entries.  When you merge two or more 
job dictionaries there is the possibility that there are entries with the same 



steno but different English definitions.  When a duplicate entry is 
displayed, you can choose which definition to use or to make a conflict of 
the two definitions. 

 
 
October 22, 2014 
File Management Program – several changes have been made to the File 
management program including: 

1. Support for longer file names, up to the maximum Microsoft Windows file 
name length.  This is the first step increasing the maximum job name 
length (currently 24) and also allows you to copy files with long file names 
and long file types (such as the Diamante note file names). 

2. On some very large hard drives the calculated space used was incorrect.  
This has been corrected. 

3. Other minor enhancements. 
 
 
October 12, 2014 

 Print and Multipag – passwords are now optional when making a PDF file.  To 
set a password, after checking the box “Export to PDF” click on the PDF 
Options button.  There you can type in a password.   
Notes: 
1. You will have to tell the password to the recipients in order for them to 

open and view the PDF files. 
2. The Print and Multipag programs will remember several passwords you 

have used.  Just click on the down arrow at the end of the password to 
see previous passwords. 

3. The passwords will remain visible and not replaced with asterisks in the 
event that you forget the password you used. 

 Dictionary Management – when reviewing your batch file or editing your 
personal or job dictionary the “Find English” search has been enhanced.  You 
now have the option to search for entries that starts with or ends with a word 
or partial word or contains a word or partial word.  In addition the “Find 
English” will remember words you have previously searched for. 

 The Read and Real-time programs have been updated to work with the 
Passport Touch.  Information about using the Passport Touch with AristoCAT 
can be found under Tutorials on the Resources icon. 

 Several glitches have been fixed.  These glitches do not happen very often 
but it is recommended to update your software. 

 
 
July 31, 2014 
This is the first version of the July 14 Master Load and Update.  This first version 
is identical to the October 2012 Master Load and Update.  See the October 2012 
PDF file for changes to the software. 
 



 
 


